
日本 Apache Camel ユーザ会

「Apache Camel 適用事例紹介 ＆ 超入門」
～お遊び感覚でお気軽に！！ ～

「Apache Camel 適用事例紹介 ＆ 超入門」
～お遊び感覚でお気軽に！！ ～

日本 Apache Camel ユーザ会
椎葉 雅志

2012年 6月 16日 （土）



日本 アパッチ キャメル ユーザ会

発表者発表者

� 椎葉 雅志（しいば まさし）

� やっていること

� 以前：

EAI/BPM製品の展開、導入支援

SOA関連情報の展開

� 最近：

Camelを使って既存商用EAI製品案件勢力図をぬりか

えるべく活動中

（といいつつ、私も Camel 初心者です！！）

� 椎葉 雅志（しいば まさし）

� やっていること

� 以前：

EAI/BPM製品の展開、導入支援

SOA関連情報の展開

� 最近：

Camelを使って既存商用EAI製品案件勢力図をぬりか

えるべく活動中

（といいつつ、私も Camel 初心者です！！）



日本 アパッチ キャメル ユーザ会
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Apache Camelとは？
～何ができるか？ その１～
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� 例えば、手作業を効率化� 例えば、手作業を効率化

担当者

社内サーバ 外部の会社 社内サーバ 外部の会社

Camel導入前 Camel導入後

CamelCamelCamelCamel

・担当者が手作業で実施 ・Camelが自動で実施

手作業で
再投入

Camelで
自動流通
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Apache Camelとは？
～何ができるか？ その２～
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� 例えば、スパゲティな連携を簡素化� 例えば、スパゲティな連携を簡素化

新規サーバ

・メンテナンスが煩雑
・各システムが接続先を意識

新規サーバ

CamelCamelCamelCamel

・メンテナンスはCamelに集約
・Camelが接続先を振り分ける

JDBC

FTP

JMS

SOAP
SOAP

SOAP

JDBC

FTP

SOAP

３つの接続
先を意識

接続先は
ひとつ
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� 例えば、Camelが持っている機能を利用して…� 例えば、Camelが持っている機能を利用して…

CamelCamelCamelCamel一定間隔/決まった日時に
特定の処理を実行

ラウンドロビンでの
負荷分散

CamelCamelCamelCamel

流通データ量の制御
CamelCamelCamelCamel

シェルコマンド実行

サーバA

サーバB

・NW帯域制限
・マシンリソース制限
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� Camelと他の機能を組み合わせると…� Camelと他の機能を組み合わせると…

CamelCamelCamelCamelCamelCamelCamelCamel

◆ Camelに機能追加

ESB
製品として実現
・Apache ServiceMix
・Talend

CamelCamelCamelCamelCamelCamelCamelCamel

◆ Camelと別機能の組合せ

BPM＋ EAI/BPM

CamelCamelCamelCamelCamelCamelCamelCamel Rule＋ CEP
*ESB ： Enterprise Service Bus
*EAI/BPM ： Enterprise Application Integration / Business Process Management
*CEP ： Complex Event Processing
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*CEP ： Complex Event Processing
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Apache Camelの適用事例紹介
～ その① ～

Apache Camelの適用事例紹介
～ その① ～

� 既にそこそこの規模のシステムで稼動しています

� 案件概要
・ 業種：？？？
・ システムカバー範囲：東日本全域
・ その他：システム更改時に商用EAI製品をApache Camelへリプレース

� 特色
Apache Camelを利用し以下のプロトコルによる他システム連携を実施

・ SOAP連携
・ JDBC連携(Ｏｒａｃｌｅ接続)
・ JMS（Oracle Advanced Queue）連携
・ HTTP連携

� Apache Camel 導入による感想
・ 商用EAI製品と遜色ない生産性、品質の確保（バグの発生が少なく強化試験を実
施）
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� ハードウェア構成（一部抜粋）

� Apache Camelを導入するにあたり個別のハ
ード等の準備はしておらず、ＡＰサーバと同居
構成（同一ＶＭ上で動作）としている

� ハードウェア構成（一部抜粋）

� Apache Camelを導入するにあたり個別のハ
ード等の準備はしておらず、ＡＰサーバと同居
構成（同一ＶＭ上で動作）としている

WebWebWebWebサーバサーバサーバサーバ DBDBDBDBサーバサーバサーバサーバ

EAI/BPM/EAI/BPM/EAI/BPM/EAI/BPM/
APAPAPAPサーバサーバサーバサーバ

【EAI/BPM/APサーバ構成】
Intel Xeon E5506 2.13GHz 1P/4C×1 , 6ポートNIC×1 , 2ポートFC×1 , 内蔵ディスクなし
4GB 2Rx4 PC3-10600R-9 メモリキット×12（48GB/台）

他他他他システムシステムシステムシステムやややや
サブシステムサブシステムサブシステムサブシステム群群群群

他他他他システムシステムシステムシステムやややや
サブシステムサブシステムサブシステムサブシステム群群群群
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Apache Camelの適用事例紹介
～ その① ～
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� ソフトウェアスタック（EAI/BPM/APサーバ）
� この案件では、外部システム・内部サブシステムI/F接続部

にApache Camelを利用

� OSS製品利用の取り組み観点においては、旧システムに
おいて利用していた商用BPM製品のOSSリプレース（jBPM
への置換）も同時に実施している
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� OSS製品利用の取り組み観点においては、旧システムに
おいて利用していた商用BPM製品のOSSリプレース（jBPM
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ＥＡＩＥＡＩＥＡＩＥＡＩモデルモデルモデルモデル
（Ｗｅｂ（Ｗｅｂ（Ｗｅｂ（Ｗｅｂアプリケーションアプリケーションアプリケーションアプリケーション））））

ＪＲＥ６

ＪＢｏｓｓインスタンス

ＥＡＩＥＡＩＥＡＩＥＡＩライブラリライブラリライブラリライブラリ群群群群 ＢＰＭライブラリ群

ＢＰＭモデル
（定義・実行クラス）

ＪＢＰＭＣａｍｅｌ／ＳｐｒｉｎｇＣａｍｅｌ／ＳｐｒｉｎｇＣａｍｅｌ／ＳｐｒｉｎｇＣａｍｅｌ／Ｓｐｒｉｎｇ
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Apache Camelの適用事例紹介
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Apache Camelの適用事例紹介
～ その② ～

� CamelとｊBoss Rulesを組合せ、CEPとして
利用。大量データの検証

� CamelとｊBoss Rulesを組合せ、CEPとして
利用。大量データの検証

クライアントクライアントクライアントクライアント
((((大量大量大量大量データデータデータデータ生成生成生成生成))))

DBDBDBDBサーバサーバサーバサーバ
Apache CamelApache CamelApache CamelApache Camel＋＋＋＋
ｊｊｊｊBoss RulesBoss RulesBoss RulesBoss Rules＋＋＋＋

TomcatTomcatTomcatTomcat
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Apache Camelの適用事例紹介
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� Ruleで大量データをフィルタリング

� CamelのAggregatorでメッセージ集約

� Ruleで大量データをフィルタリング

� CamelのAggregatorでメッセージ集約

【【【【RuleRuleRuleRule】】】】
条件条件条件条件にににに合致合致合致合致しないしないしないしない
データデータデータデータははははゴミゴミゴミゴミ箱行箱行箱行箱行きききき

×

【【【【AggregatorAggregatorAggregatorAggregator】】】】
同同同同じじじじタイプタイプタイプタイプのののの

データデータデータデータをまとめるをまとめるをまとめるをまとめる

DBに書
込み
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メッセージルーティングメッセージルーティングメッセージルーティングメッセージルーティング
メッセージメッセージメッセージメッセージ

メッセージメッセージメッセージメッセージ変換変換変換変換 分割分割分割分割

エンタープライズ統合
のノウハウ

汎用的な
パターン

メッセージチャネルメッセージチャネルメッセージチャネルメッセージチャネル

必要な機能を定義 利用時の留意点を定義

⇒⇒CamelCamelでは多くのでは多くのEIPEIPのパターンが実現可能のパターンが実現可能

汎用的な設計パターンをGoFデザインパターンとして定義したように、
エンタープライズ統合のパターンを定義
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コ
ア
機
能

Camel概要
～優れた拡張性 １/２～

Camel概要
～優れた拡張性 １/２～

� 必要なコンポーネントのみ利用可能
� 不要なコンポーネントは使わなくてよい

� ない場合は自分で作成可能

� 必要なコンポーネントのみ利用可能
� 不要なコンポーネントは使わなくてよい

� ない場合は自分で作成可能

Apache
CXF SOAP

Jetty

Apache
ActiveMQ

HTTP

ＪＭＳ

CamelCamelCamelCamelがががが提供提供提供提供 他他他他OSSOSSOSSOSS
をををを利用利用利用利用

File
ファイル

コンポーネント

判例

：コンポーネント

：OSS/ライブラリ

Webサービ
ス用Lib

HTTP用
Lib

JMS用
Lib

自作
Lib OSS Lib

個別
プロトコル
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Camel概要
～優れた拡張性 ２/２ ～

Camel概要
～優れた拡張性 ２/２ ～

� 単純なプロトコルスタック

� コア機能は他ライブラリの依存性が低い

� 他システムへの組込み/組合せが容易
� ESB、CEPやEAI/BPMへの拡張が可能

� 単純なプロトコルスタック

� コア機能は他ライブラリの依存性が低い

� 他システムへの組込み/組合せが容易
� ESB、CEPやEAI/BPMへの拡張が可能

http://servicemix.apache.org/architecture.htmlより引用

オープンソースESBの
ServiceMixの場合

Camelと他OSSを
組み合わせて実現
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Camel概要
～多数のコンポーネント １/２～

Camel概要
～多数のコンポーネント １/２～

� １００以上のコンポーネント� １００以上のコンポーネント

AHC

AMQP

APNS

Atom

AWS-SNS

AWS-SQS

AWS-S3

Bean

Bean Validation

Browse
Cache

Cometd

Context

CXF

CXF Bean

CXF RS

DataSet

Direct

DNS

EJB

EventAdmin Exec

File

Flatpack

FreeMarker

FTP

Hazelcast
HDFS

HL7

HTTP

HTTP4

iBATIS
IMap

IRC

JBI

JCR

JMS

JMX

JPA

JT/400

Kestrel

LDAP

Log

Lucene

Mail

MINA

Mock
MyBatis

Netty

POP

Quartz

RMI

RSS

Sip

SFTP

SERVLET

SMPP

SMTP

SNMP

SpringIntegration

SQL

Stream

StringTemplate
TCP

Test
Timer

XQuery

連携用のコンポーネント 役立ちそうなコンポーネント EIPのコンポーネント

Event
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Camel概要
～多数のコンポーネント ２/２～

Camel概要
～多数のコンポーネント ２/２～

� AWS,GAE等、注目のクラウド環境にも対応� AWS,GAE等、注目のクラウド環境にも対応

Apache CamelApache CamelApache CamelApache Camel

S3
SNS SQS

OAuth
Mail Service

Amazon
Web
Service

Google
App
Engine

Task Queuing Service URL Fetch Service

コア機能
HTTP用

Lib

AWS用
Lib

Apache CamelApache CamelApache CamelApache Camel

コア機能
HTTP用

Lib

GAE用
Lib

HTTP用
Lib
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Camel

Camelの使い方Camelの使い方

使い方の概要
① Camelコンテキストを作成（おまじない）
② 全体の処理の流れをルーティングとして定義
③ ルーティング内の個々の処理をコンポーネント(部品)で実現
④ 実行時、定義済みのルーティングに従い、メッセージが流通

使い方の概要
① Camelコンテキストを作成（おまじない）
② 全体の処理の流れをルーティングとして定義
③ ルーティング内の個々の処理をコンポーネント(部品)で実現
④ 実行時、定義済みのルーティングに従い、メッセージが流通

JMSJMSJMSJMS

WS
コネクタ

チェック

JDBC
コネクタ

JMS
コネクタ

データ
変換

SOAP

JDBC

振分け

データ
変換 JMS

④④④④メッセージメッセージメッセージメッセージ

③部品
(コンポーネント)

実際はJavaもしくはSpring用XMLでルーティングを定義

②ルーティング

①Camelコンテキスト
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Camelの使い方
～ルーティング～

Camelの使い方
～ルーティング～

� DSLでルーティングを定義

� DSL：Domain Specific Language
Camel固有のルーティング記述用の言語

� 複数のDSLでルーティング定義が可能

� Java DSL

� Spring DSL

� Scala DSL

� DSLでルーティングを定義

� DSL：Domain Specific Language
Camel固有のルーティング記述用の言語

� 複数のDSLでルーティング定義が可能

� Java DSL

� Spring DSL

� Scala DSL
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Camelの使い方
～ルーティング～

Camelの使い方
～ルーティング～

� ルーティングの基本� ルーティングの基本

<Java DSLで記述> <Spring DSLで記述>

from(“コンポーネント１情報”)
.to(“コンポーネント２情報”)
.to(“コンポーネント３情報”)
.to(“コンポーネント４情報”);

<route>
<from uri=“コンポーネント１情報” />

<to uri=“コンポーネント２情報” />
<to uri=“コンポーネント３情報” />
<to uri=“コンポーネント４情報” />

</route>

Camel
コンポー
ネント１

コンポー
ネント２

コンポー
ネント４

コンポー
ネント３

ルーティングルーティングルーティングルーティング
のののの範囲範囲範囲範囲

処理処理処理処理のののの
順番順番順番順番

コンポーネント情報を順番に並べる。最初がfrom、それ以降はtoでつなげる

処理処理処理処理のののの
順番順番順番順番

入力 出力

※：from、to以外にもCamelではDSLを定義している（choice, when, wireTap, etc.)
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④ 実行時、定義済みのルーティングに従い、メッセージが流通

使い方の概要
① Camelコンテキストを作成（おまじない）
② 全体の処理の流れをルーティングとして定義
③ ルーティング内の個々の処理をコンポーネント(部品)で実現
④ 実行時、定義済みのルーティングに従い、メッセージが流通

JMSJMSJMSJMS

WS
コネクタ

チェック

JDBC
コネクタ

JMS
コネクタ

データ
変換

SOAP

JDBC

振分け

データ
変換 JMS

③部品
(コンポーネント)
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Camelの使い方
～コンポーネント～

Camelの使い方
～コンポーネント～

� コンポーネントはURIで指定� コンポーネントはURIで指定

/tmp/abcフォルダを5秒間隔でポーリング

file:/tmp/abc?delay=5000

/tmp/abcフォルダを5秒間隔でポーリング

file:/tmp/abc?delay=5000

スキーマ名：必須項目[？オプション]

コンポーネント
を識別するユ
ニークな名前

URIの必須情報 ・URIのオプション情報(複数記述可能)
・複数記述する場合は‘＆’でつなげる

<URIの基本>
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Camelの使い方
～コンポーネント～

Camelの使い方
～コンポーネント～

� オプション指定で更に便利に！� オプション指定で更に便利に！

file:/tmp/abc?delay=5000&move=.donefile:/tmp/abc?delay=5000&move=.done

file:/tmp/abc?delay=5000&recursive=truefile:/tmp/abc?delay=5000&recursive=true

処理後、.doneディレクトリ
にファイルを移動したい

フォルダを再帰的に
ポーリングしたい

新たな要件の追加
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Camelの使い方
～コンポーネント～

Camelの使い方
～コンポーネント～

� 各種プロトコルに対応したコンポーネント

� 書式はすべて「スキーマ名：必須項目？オプション」
� プロトコル個別のお作法を学ぶ手間が低減

� 各種プロトコルに対応したコンポーネント

� 書式はすべて「スキーマ名：必須項目？オプション」
� プロトコル個別のお作法を学ぶ手間が低減

log:loggingCategory[?options]-Log

jdbc:dataSourceName[?options]JDBCJDBC

ghttp://hostname[:port][/path][?options]
ghttp:///path[?options]

URL fetch service
(Google App Engine）

GHｔｔｐ

aws-s3://bucketname[?options]Amazon Simple 
Storage
Service(S3)

AWS-S3

jms:[queue:|topic:]destinationName[?options]JMSJMS

jetty:http://hostname[:port][/resourceUri][?options] HTTP（サーバ)Jetty

ftp://[username@]host[:port]/directoryname[?options]FTP/SFTP/FTPSFTP/SFTP/FTPS

file:fileOrDirectoryName[?options]FileFile

cxf:address[?serviceClass=...]WebサービスCXF

URIプロトコルコンポーネント

URIの記述例
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Camel

Camelの使い方
～ルーティング例～

Camelの使い方
～ルーティング例～

� ルーティングの記述例

� 他システムへのファイル送信

� ルーティングの記述例

� 他システムへのファイル送信

File
コネクタ

File
コネクタ

from(“file:/a/b”)
.to(“log:testlog”)
.to(“ftp:/receive”);

<route>
<from uri=“file:/a/b” />
<to uri=“log:testlog” />
<to uri=“ftp:/receive” />

</route>

<Java DSLで記述した場合> <Spring DSLで記述した場合>

※：ルーティング部分にフォーカスを当て、前後の処理は省略。以降も同様

他システム
FTP

/a/b/test.txt test.txt

/receiveLog出力
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Camel

Camelの使い方Camelの使い方

使い方の概要
① Camelコンテキストを作成（おまじない）
② 全体の処理の流れをルーティングとして定義
③ ルーティング内の個々の処理をコンポーネント(部品)で実現
④ 実行時、定義済みのルーティングに従い、メッセージが流通

使い方の概要
① Camelコンテキストを作成（おまじない）
② 全体の処理の流れをルーティングとして定義
③ ルーティング内の個々の処理をコンポーネント(部品)で実現
④ 実行時、定義済みのルーティングに従い、メッセージが流通

JMSJMSJMSJMS

WS
コネクタ

チェック

JDBC
コネクタ

JMS
コネクタ

データ
変換

SOAP

JDBC

振分け

データ
変換 JMS

④④④④メッセージメッセージメッセージメッセージ
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Camelの使い方
～内部で流通するメッセージ形式～

Camelの使い方
～内部で流通するメッセージ形式～

� メッセージの話をする前に、少しだけ一般論� メッセージの話をする前に、少しだけ一般論

厳密厳密厳密厳密にににに型型型型をををを定義定義定義定義 利用者利用者利用者利用者がががが型型型型のののの内容内容内容内容をををを意識意識意識意識

入力
処理

処理X
出力
処理

入力
処理

処理X
出力
処理

XXXX YYYY

のののの型型型型のみのみのみのみ
流通流通流通流通をををを許容許容許容許容

のののの型型型型のみのみのみのみ
流通流通流通流通をををを許容許容許容許容

のののの中中中中にににに何何何何がどのようにがどのようにがどのようにがどのように入入入入っっっっ
ているかているかているかているか、、、、ユーザユーザユーザユーザがががが意識意識意識意識

・・・・ユーザユーザユーザユーザははははデータデータデータデータへのへのへのへのアクセスアクセスアクセスアクセスがががが容易容易容易容易
・・・・全全全全てのてのてのての型定義型定義型定義型定義をををを設計時設計時設計時設計時にににに実施実施実施実施

・・・・設計時設計時設計時設計時にににに型定義型定義型定義型定義がががが不要不要不要不要
・・・・データデータデータデータへのへのへのへのアクセスアクセスアクセスアクセスをををを各処理各処理各処理各処理でででで実施実施実施実施

CamelCamelCamelCamelはこのはこのはこのはこの方法方法方法方法
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Camelの使い方
～メッセージ形式～

Camelの使い方
～メッセージ形式～

� メッセージは“Header”と“Body”からなる� メッセージは“Header”と“Body”からなる

メッセージ

Header

Body

データ以外の情報を格納

流通データを格納

メッセージの構成

Exchange

※：実際はExchange内に2つのメッセージがある(InMessage、OutMessage)
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Camelの使い方
～メッセージ形式 Header～

Camelの使い方
～メッセージ形式 Header～

� データ以外の情報がHeader部に詰まっている� データ以外の情報がHeader部に詰まっている

�例えば、ファイル名やディレクトリ名を格納
�「キー＝値」の形式で格納
�プロトコル毎に格納されるキーが異なる
�ユーザが自由に追加/変更可能

メッセージ

Header

Body

[CamelFilePath=C:¥work¥abc¥File.txt]
[CamelFileLength=320]
[CamelFileLastModified=yyyy/mm/dd]
…

[Content-Type=text/xml;charset=UTF-8]
[operationNameSpace=http://ws.test.co.jp/]
[operationName=helloEcho]
…

ファイル受信時のヘッダ情報の例 Webサービス受信時のヘッダ情報の例
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Camelの使い方
～メッセージ形式 Body～

Camelの使い方
～メッセージ形式 Body～

� Body部には流通データが詰まっている� Body部には流通データが詰まっている

�流通するデータを格納
�データの格納方法はプロトコルで異なる
�データ以外の情報を格納しているプロトコ

ルもある

メッセージ

Header

Body

◆クラス名は
org.apache.camel.component.file.GenericFile
◆処理対象のファイル情報を格納

◆クラス名は
org.apache.cxf.message.MessageContentsList
◆受信データのリスト、引数のデータが順番に格納

ファイル受信時のBody部 Webサービス受信時のBody部
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Camelの使い方
～データ変換～

Camelの使い方
～データ変換～

� 容易にBody部のデータ取得する方法を提供� 容易にBody部のデータ取得する方法を提供

ファイル
入力処理

処理X
ファイル

出力処理

データアクセス手段がないと…

・メッセージの中のデータへのアクセス
手段を各処理で実装する必要がある

publicpublicpublicpublic classclassclassclass Process implementsimplementsimplementsimplements Processor {

publicpublicpublicpublic voidvoidvoidvoid process(Exchange exchange) throwsthrowsthrowsthrows Exception {

String data = exchange.getIn().getBody(String.classclassclassclass);

…

publicpublicpublicpublic classclassclassclass Process implementsimplementsimplementsimplements Processor {

publicpublicpublicpublic voidvoidvoidvoid process(Exchange exchange) throwsthrowsthrowsthrows Exception {

String data = exchange.getIn().getBody(String.classclassclassclass);

…

ExchangeExchangeExchangeExchange InMessageInMessageInMessageInMessage BodyBodyBodyBody部部部部ををををStringStringStringStringでくれでくれでくれでくれ！！！！

処理XはメッセージのBody部が
Stringかbyte[]かInputStream
か知らなくてもアクセスできる

「処理X」でのデータアクセス手段



日本 アパッチ キャメル ユーザ会

Camelの使い方
～データ変換～

Camelの使い方
～データ変換～

� TypeConverterによる変換� TypeConverterによる変換

ファイル
入力処理

処理X

Header

Body

メッセージ

Object->Byte

Map->Set

byte[]->String

byte[]->Document

File->InputStream

File->String

Body部は
byte[]で主力

Body部は
Stringを期待

TypeConverterによる自動型変換を実施

出力と入力でBody部
の型が不一致の場合

Body部は
byte[]

TypeConverterに
存在しない型変換が

必要な場合は、
ユーザが作成する

ことも可能
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Camelの使い方
～実際にやってみる～

Camelの使い方
～実際にやってみる～

� 例えば…
ファイルをコピーする処理を考えてみる

� 例えば…
ファイルをコピーする処理を考えてみる

フォルダフォルダフォルダフォルダからからからから
ファイルファイルファイルファイルをををを
取得取得取得取得するするするする

フォルダフォルダフォルダフォルダにににに
ファイルファイルファイルファイルをををを
出力出力出力出力するするするする

ファイルコピー処理ファイルコピー処理
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Camelの使い方
～Javaで書いてみる～

Camelの使い方
～Javaで書いてみる～

� Javaでも簡単に記述可能� Javaでも簡単に記述可能
publicpublicpublicpublic staticstaticstaticstatic voidvoidvoidvoid main(String args[]) throwsthrowsthrowsthrows Exception {
File inboxDirectory = newnewnewnew File("data/inbox");
File outboxDirectory = newnewnewnew File("data/outbox");
outboxDirectory.mkdir();
File[] files = inboxDirectory.listFiles();
forforforfor (File source : files) {
File dest = newnewnewnew File(outboxDirectory.getPath() + File.separator + source.getName());
copyFile(source, dest);

}
}
privateprivateprivateprivate staticstaticstaticstatic voidvoidvoidvoid copyFile(File source, File dest) throwsthrowsthrowsthrows IOException {
OutputStream out = newnewnewnew FileOutputStream(dest);
bytebytebytebyte[] buffer = newnewnewnew bytebytebytebyte[(intintintint) source.length()];
FileInputStream in = newnewnewnew FileInputStream(source);
in.read(buffer);
trytrytrytry {
out.write(buffer);

} finallyfinallyfinallyfinally {
out.close();
in.close();

}
}

publicpublicpublicpublic staticstaticstaticstatic voidvoidvoidvoid main(String args[]) throwsthrowsthrowsthrows Exception {
File inboxDirectory = newnewnewnew File("data/inbox");
File outboxDirectory = newnewnewnew File("data/outbox");
outboxDirectory.mkdir();
File[] files = inboxDirectory.listFiles();
forforforfor (File source : files) {
File dest = newnewnewnew File(outboxDirectory.getPath() + File.separator + source.getName());
copyFile(source, dest);

}
}
privateprivateprivateprivate staticstaticstaticstatic voidvoidvoidvoid copyFile(File source, File dest) throwsthrowsthrowsthrows IOException {
OutputStream out = newnewnewnew FileOutputStream(dest);
bytebytebytebyte[] buffer = newnewnewnew bytebytebytebyte[(intintintint) source.length()];
FileInputStream in = newnewnewnew FileInputStream(source);
in.read(buffer);
trytrytrytry {
out.write(buffer);

} finallyfinallyfinallyfinally {
out.close();
in.close();

}
}
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Camelの使い方
～Camelでやってみる～

Camelの使い方
～Camelでやってみる～

� Camelの場合（Java DSL)� Camelの場合（Java DSL)publicpublicpublicpublic staticstaticstaticstatic voidvoidvoidvoid main(String args[]) throwsthrowsthrowsthrows Exception {

//1：最初にCamelContextを作成する
CamelContext context = newnewnewnew DefaultCamelContext();
RouteBuilder routeBuilder = newnewnewnew FileToFileRoute();
context.addRoutes(routeBuilder);

//2:作成したCamelContextを開始し、10秒後に終了する
context.start();
Thread.sleep(10000);
context.stop();

}

publicpublicpublicpublic staticstaticstaticstatic voidvoidvoidvoid main(String args[]) throwsthrowsthrowsthrows Exception {

//1：最初にCamelContextを作成する
CamelContext context = newnewnewnew DefaultCamelContext();
RouteBuilder routeBuilder = newnewnewnew FileToFileRoute();
context.addRoutes(routeBuilder);

//2:作成したCamelContextを開始し、10秒後に終了する
context.start();
Thread.sleep(10000);
context.stop();

}

publicpublicpublicpublic classclassclassclass FileToFileRoute extendsextendsextendsextends RouteBuilder {

@Override
publicpublicpublicpublic voidvoidvoidvoid configure() throwsthrowsthrowsthrows Exception {
from("file:data/inbox?noop=true")

.to("file:data/outbox");
}

publicpublicpublicpublic classclassclassclass FileToFileRoute extendsextendsextendsextends RouteBuilder {

@Override
publicpublicpublicpublic voidvoidvoidvoid configure() throwsthrowsthrowsthrows Exception {
from("file:data/inbox?noop=true")

.to("file:data/outbox");
}
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Camelの使い方
～要件の考慮～

Camelの使い方
～要件の考慮～

� ところが、普通はもっと要件が複雑…
例えば、

� 1分毎にファイルがあるかチェックすること

� 出力ファイル名には日付を付与すること

� .docの付いた拡張子は無視すること

� 同一のファイル名がある場合は無視すること

� サブフォルダも検索すること

� コピーでなく移動に変更。バックアップも取って！

� etc,…

� ところが、普通はもっと要件が複雑…
例えば、

� 1分毎にファイルがあるかチェックすること

� 出力ファイル名には日付を付与すること

� .docの付いた拡張子は無視すること

� 同一のファイル名がある場合は無視すること

� サブフォルダも検索すること

� コピーでなく移動に変更。バックアップも取って！

� etc,…
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Camelの使い方
～追加要件への対応～

Camelの使い方
～追加要件への対応～

� Camelの場合、オプション追加で対応可能� Camelの場合、オプション追加で対応可能

publicpublicpublicpublic classclassclassclass FileToFileRoute extendsextendsextendsextends RouteBuilder {

@Override

publicpublicpublicpublic voidvoidvoidvoid configure() throwsthrowsthrowsthrows Exception {
from(“ file:data/inbox? delay=60000 & exclude=*.doc$ & move=.done &

noop=false & idempotent=true & recursive=true")

.to("file:data/outbox? fileName=${date:now:yyyy-MM-dd}_${file:name}");

}

publicpublicpublicpublic classclassclassclass FileToFileRoute extendsextendsextendsextends RouteBuilder {

@Override

publicpublicpublicpublic voidvoidvoidvoid configure() throwsthrowsthrowsthrows Exception {
from(“ file:data/inbox? delay=60000 & exclude=*.doc$ & move=.done &

noop=false & idempotent=true & recursive=true")

.to("file:data/outbox? fileName=${date:now:yyyy-MM-dd}_${file:name}");

}

1分毎にファイルがあるかチェック

出力ファイル名には日付を付与

.docの付いた拡張子は無視

同一のファイル名がある場合は無視

サブフォルダも検索

コピーから移動に変更

.doneフォルダにバックアップ
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さいごに（その①）
～様々な立場におけるApache Camel～

さいごに（その①）
～様々な立場におけるApache Camel～

� インテグレータ View
� 安価なシステム提案

→ イニシャルコストなし

→ ランニングコストはメンテナンスに必要な稼動を請求！？

� 国内でApache Camel先駆者となれる
→ 国内での利用ユーザはほんの僅か、

使い倒して競合他社との差別化！？

� 容易な開発体制の確立
→ 専門技術者を集める必要なし、Java技術者にて開発可能

� インテグレータ View
� 安価なシステム提案

→ イニシャルコストなし

→ ランニングコストはメンテナンスに必要な稼動を請求！？

� 国内でApache Camel先駆者となれる
→ 国内での利用ユーザはほんの僅か、

使い倒して競合他社との差別化！？

� 容易な開発体制の確立
→ 専門技術者を集める必要なし、Java技術者にて開発可能
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さいごに（その①）
～様々な立場におけるApache Camel～

さいごに（その①）
～様々な立場におけるApache Camel～

� エンドユーザ View
� 安価なシステム構築

→ イニシャルコストなし

→ 必要なのはメンテナンス費用（≒保守費）

→ ポジティブに考えるといつでも捨てれる！？

→ OSSの積極的な利用によるコストダウン体制をアピール

� エンドユーザ View
� 安価なシステム構築

→ イニシャルコストなし

→ 必要なのはメンテナンス費用（≒保守費）

→ ポジティブに考えるといつでも捨てれる！？

→ OSSの積極的な利用によるコストダウン体制をアピール



日本 アパッチ キャメル ユーザ会

さいごに（その②）
～ユーザ会を立ち上げました～

さいごに（その②）
～ユーザ会を立ち上げました～

� 皆さんにCamelを知って欲しい！

� 日本Apache Camelユーザ会

【お勉強系サイト】

http://sourceforge.jp/projects/cameluserjp/

【キャラ系サイト】

https://sites.google.com/site/jaacug/

� 主な活動内容
� Camelのドキュメント翻訳

� Camelのサンプル実装

等をやりたいと思っています。

� 皆さんにCamelを知って欲しい！

� 日本Apache Camelユーザ会

【お勉強系サイト】

http://sourceforge.jp/projects/cameluserjp/

【キャラ系サイト】

https://sites.google.com/site/jaacug/

� 主な活動内容
� Camelのドキュメント翻訳

� Camelのサンプル実装

等をやりたいと思っています。
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ご静聴
ありがとうございました


